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Crystal Reports for Visual Studio .NET  Glossary 

 
  

Term/Phrase Description 
Absolute formatting Formatting that is always applied to an object. 

Active database Database that has been selected for use in a report. 

Aggregate function Operation that summarizes data - sums, calculates an average, 
identifies a maximum value, etc. 

Alias Alternative name assigned to a data source or a database table. 

Area Group of related sections that all share the same characteristics but can 
be formatted differently. 

Argument An item or one of a group of items that receives the action of a function. 
and provides information that the function needs in order to operate. 

Attribute A quality applied to an object. 

Bitmap Graphic file that can be added to a report. 

BLOB field A database field whose data consists of Binary Large Objects - bitmap 
graphics, images, OLE objects, metafiles, etc. 

Boolean Formulas that return a Yes/No (TRUE/FALSE) value. 

Boolean expression An expression that defines a logical relationship between two or more 
items which is either TRUE or FALSE. 

Calculated data field A field that holds a value that comes from a calculation rather than 
coming directly from a database. 

Case-sensitive Differentiation between uppercase and lowercase letters when 
evaluating a text string. 

Column Display of data from a single field or formula. 

Condition In an If-Then-Else formula, the condition is the If part of the formula. 

Conditional formatting Formatting that applies only if certain situations occur. 

Conditional formatting formula An expression that applies specific attributes to objects or sections only 
if certain criteria are met. 

Conditional property Properties that are performed on an object only if a comparison 
statement returns a value of True. 

Consequence In an If-Then-Else formula, the consequence is the Then part of the 
formula and the action that takes place if the If condition is met. 

Constant Value that is fixed and unchanging; in contrast to a variable. 

Container document File that contains an embedded or linked OLE object. 

Conversion interface file It is the file in which the program saves the formatting and highlighting 
from the Document Import Tool. It has the .cif extension. 

Cross-tab Report that summarizes and presents data in a concise row and column 
format. 

Custom function Procedure created in Crystal Reports to evaluate, make calculations on, 
or transform data. 

Database Structure serving as a repository for related data comprised of records; 
each record is made up of one or more data fields. 

Data field Building block of a record with each record being made up of one or 
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Term/Phrase Description 
more data fields, and each data field holding one piece of data known 
as a value. 

Data source A database, table, query, dictionary, Info View, Business View, or 
stored procedure result set that provides the data for a report. 

Data type A classification of the data that appears in a field or formula. Each piece 
of data used in a report or formula has one of the following data types: 
string, currency, number, date, date/time, time, or Boolean 
(TRUE/FALSE). 

Debug Eliminating errors that occur when you run a formula. 

Default A pre-loaded response to a software request for data. It is the response 
the computer accepts automatically if you do not enter different data. 

Details area A collection of one or more Details sections. 

Details section The Details section of a report is the core section of the report. You 
structure the report in this section by inserting data fields, formulas, and 
other report elements. 

Dictionary A ready-to-use source of data that is usually created for end users by 
computer professionals within the organization. The dictionary takes 
away the need for the end user to search multiple databases, struggle 
with links, build formulas, and decode cryptic field names. 

Drag To click an object and, while keeping the mouse button pressed, move 
the frame to a new position. The mouse button is released when the 
field is in the desired position. 

Dynamic Link Library (DLL) A special kind of file that contains Windows functions. DLLs are used by 
developers to extend the capabilities of Windows applications. 

Element Individual report components such as database fields, formulas, and 
group fields. 

Evaluation time Evaluation time refers to the stage in the reporting process when a 
formula gets evaluated. 

Expert Tools designed to take the developer through various aspects of report 
creation by using a series of tabs. 

Export Reports from Crystal Reports can be exported to a disk file or through 
email. 

Field The basic building block of a record. Each record is made up of one or 
more data fields, and each data field can hold one piece of data known 
as a value. 

Field value See value. 

Field width Size of the field in the originating database. 

File A collection of related data stored is under one name. In Crystal 
Reports, each report is stored as a single file. 

Fixed property Properties that will always be performed on the object. 

Footer The text that appears at the bottom of a report page. Footer text 
frequently includes page numbers. 

Form letter A letter that can be reproduced, personalized, and customized using the 
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program’s powerful text object capabilities. 

Formula A symbolic statement of the modifications that are to be performed on 
certain data before it is printed on a report. 

Formula Workshop Used to create and edit formulas in Crystal Reports. It consists of a 
toolbar, a tree that lists the types of formulas that can be created or 
modified and an area for defining the formula. 

Formula syntax Grammar rules to be followed when creating formulas using the formula 
language. 

Free form Placement of objects is not limited to grids. 

Function Procedure or subroutine used to evaluate, make calculations on, or 
transform data. 

Grand total Summary of all values in a column for the entire report. 

Grid An underlying network of “lines” that are similar to the lines on graph 
paper which can be used for aligning fields and graphics. 

Group Set of records that are related to each other in some way. 

Group Footer Section created by the program whenever a group, a summary, or a 
subtotal is inserted. It is typically used to display the summary or 
subtotal. 

Group Header Section created by the program whenever a group, a summary, or a 
subtotal is inserted.  It is typically used to display the name of the group 
or some other identifying information. 

Guideline Non-printing lines that can be used to align, move, and resize objects 
with precision.  It serves to aid when working in a free form environment 
without a grid. 

Header Text that appears at the top of a report page, above the body of the 
report.  It will typically contain items such as the report title, company 
name, date, range of dates covered by the report, etc. 

Highlighting Expert Provides a wide range of conditional formatting, including font color, 
background color, and border style. 

Index A small file that identifies the location of each record in a database. Is 
used by Crystal Reports to speed up the report generation process. 

Indexed field Fields in the database that are in a specific order to speed up the 
retrieval of particular records. 

In-place editing Ability to change an OLE object’s properties while in Crystal Reports. 

In-place ruler Ruler that appears when editing a text object and which provides the 
capability for setting tabs and positioning objects with precision. 

Insertion point A vertical line that indicates the point at which Crystal Reports will insert 
any text that has been typed in. 

Link A field that is common to two or more databases and that serves as a 
connecting point between those databases. 

Linked object A linked object contains a presentation of the object, and a pointer to a 
defined part of the server document. 

Live header A header that changes dynamically with the content of a field. 
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Map Expert A tool for organizing of data by placing geographic maps on a report 

and which users can drill-down on to see the underlying data. 

Nesting Ability to use one construct inside another. 

null There is no value within a database field for a given record.  It does not 
mean zero because zero is a value. 

null string An empty string which contains no characters. 

Numeric Data on which arithmetical calculations can be performed. 

Object Report elements that generally contain data and have specific 
properties which define behavior or appearance such as for a cross-tab, 
graph, subreport, picture, or OLE. 

Object frame Rectangular cursor that appears as an aid to placing database fields 
and formulas on a report. 

ODBC An interface that gives applications the ability to retrieve data in data 
management systems using SQL for accessing the data. 

OLE Object Linking and Embedding which provides the ability to create 
compound reports. 

OLE container application Application that can contain and process OLE objects created 
elsewhere. 

OLE server application An application that can create OLE objects which can be placed in 
documents created by container applications. Crystal Reports is a 
container application. 

On-demand subreport On-demand subreports appear only as hyperlinks in the main report. 
Only data for the on-demand subreport that is actually viewed will be 
retrieved from the database. 

One-to-many A situation occurring in linked databases in which one record in one 
database can be matched with many records in another database. 

Operator Special symbol that describes an operation or an action to take place 
between two or more values. 

Order of precedence Set of rules that determines the order in which arithmetic operations 
take place in a formula that involves multiple arithmetic operations. 

Page Footer Section that prints at the bottom of each page and which typically is 
used for page numbers, chapter names, and other identifying 
information. 

Page Header Section that prints at the top of each page.  Page headers are typically 
used for titles and other identifying information. 

Parameter field Special kind of field that prompts the user for a value. 

Paste Retrieval and placement of data from the Clipboard into a report or 
formula.  

Population Entire set of values that can be tested statistically. 

Population standard deviation Statistical test of how the values in an entire population deviate from the 
mean or average value for that population. 

Population variance Square of the standard deviation which is a measure of the amount by 
which the values in an entire population vary from the mean value for 
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that population. 

Property Qualities that define the appearance or action of an object or a section. 
There are two kinds of properties: On/Off and attribute. 

Range Set of values that fall between and include a defined upper and lower 
limit. 

Record A complete unit of related information for a given entity.  Each record 
contains one or more fields that contain the specific pieces of data of 
interest. 

Report Footer The last section of a report in the Design Tab.  

Report Gallery Dialog box that appears when the New button is clicked on the 
Standard toolbar or the New command is chosen from the File menu. 

Report Header First section of a report in the Design Tab which includes the title or any 
data that should appear on the first page of the report in this section. 

Report Part Hyperlink definitions that point from a home report object to a 
destination object. 

Repository Central location for storing and managing a report objects.  These 
objects can then be accessible to users and report developers. 

Request Set of criteria that specifies the subset of data that are required for a 
report. 

Returns Result of a function, an operator, or a formula. 

Row Display of data from a single record; rows run horizontally across a 
page. 

Ruler Visual reference for positioning and resizing fields, graphs, lines, boxes, 
and bitmaps. 

Running total Total displayed on a record by record basis.  It totals all records in the 
report, in the group, etc. up to and including the current record. 

Sample Subset of a population used to represent the entire population. 

Scroll bars, scrolling When a window can display only a portion of a document it will contain, 
scroll bars will become visible that can be used for moving other parts 
of the document into the window. 

Section The design environment is divided into several sections, each of which 
has different printing characteristics. 

Select Ability to identify and choose those records of interest while 
disregarding all others. 

Selection formula Formula that specifies the records or groups of records that need to be 
included in a report. 

Server document File that stores the original OLE object. 

Server-side processing Feature that can be set up for reports in order that the majority of its 
processing can be performed on the server. 

Shortcut menu Dynamic menu available in the Design and Preview Tabs which is 
accessed by highlighting an object and right-clicking. 

Snap property Whenever an object is moved close to a guideline or a grid coordinate, 
the program snaps it into position for accurate placement and 
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alignment. 

Sort-and-group-by field A field that triggers the printing of a subtotal or a group field value 
whenever its own value changes. 

Sort direction Describes the way records or groups are printed in a report: ascending 
or descending. 

Sort field A data field on which the sort procedure is based. 

Sort order An indicator of the direction in which the data needs to be presented 
once it is sorted: ascending or descending. 

Sorting Method of organizing the order in which data appears on the report. 

SQL Structured Query Language is a system for managing, organizing, and 
retrieving data stored on a computer database. 

SQL pass-through Ability to have SQL Server process the data retrieval criteria in order to 
pass the smallest possible result set back to Crystal Reports for final 
processing. 

Standard deviation Statistical test of how various values in a set of values deviate from the 
mean or average value for that set. 

Static OLE object Picture of an object that is stored in a document when it is saved. 

String A series of connected characters - letters, numbers, symbols, spaces - 
stored and used as text. 

Subreport A report within a report.  Subreports can be freestanding or can be 
linked to the data in the primary report. 

Substring A part of a larger string. 

Subtotal A partial total or limited group of data in a field. 

Summary Value generated as the result of an evaluation, tally, or a calculation 
performed on data from a single group. 

Summary field Field which determines the sum of the values, the average value, the 
maximum value, the minimum value, or count of values in a group of 
values in a given field. 

Suppress When an object is suppressed, it does not appear. 

Syntax Set of rules used to make a correct formula. 

Template Copy of a report used as the starting point for creating a new report or a 
new report created in the Standard Report Creation Wizard. 

Text object An object containing text, database fields, and formula fields. 

Toolbar Bar at the top of a Crystal Reports application window which contains a  
buttons that can be clicked to activate commands. 

Total A sum of values. 

Two pass formula/function A formula requiring two passes through the data for completion. The 
first pass a calculation or selection and the second pass performs a 
calculation or selection that uses the result generated by the first pass. 

Underlay Ability of an object to print beneath multiple sections which follow the 
section in which it was placed. 

Value Data found in a field. 
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Variance Measure of the amount by which all values in a group vary from the 

mean value in the group.  Square of the standard deviation. 

Verify Ability to have the report understand the changes made to the database 
structure. 

Wildcard Character that represents any character (?) or any group of characters 
(*) in a search string. 

Wizard An integrated series of screens and instructions used for creating 
reports with step-by-step instructions. 
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